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Advantages of Registering

This product is shareware. This means that this is a fully functional Random Dot Stereogram
generator, capable of generating RDS images in Black & White, Random Colors, or in Customized
color schemes specified by the user. The software will generate images up to 320x200 pixels, with
two levels of "depth” (the base level and one other level). Note that this Help file, as well as the
POPOUT-LITE main menu, have been designed for the non-shareware version of the software.
After receiving your registration, we will send you the non-shareware version of POPOUT-LITE.
Alternately, you may choose to order a registered copy of POPOUT-PRO, which has many more
stereogram generating capabilities. The lists below describe the additional features included in the
registered version of POPOUT-LITE, as well as the features of POPOUT-PRO.

POPOUT-LITE Features:

n There are no limitations placed on the Source and Destination File sizes. The registered
version of POPOUT-LITE will create Random Dot Stereograms of any size.

n The registered version is capable of generating up to 16 levels of depth in the Destination file
stereogram.

n The Pixel Density parameter is included, allowing the user to specify the percentage of
foreground pixels generated for Black & White and Custom Color RDS images.

POPOUT-PRO Features:
POPOUT-PRO has all of the capabilities of POPOUT-LITE, plus the following:
n The non-shareware version of the software is capable of generating Dual-Image stereogram

images, where a Background Image supplied by the user is tiled and distorted to create the
hidden image.

n The non-shareware version will read and write both BMP and Targa formatted images. Since
Targa is the "format of choice" of popular ray-tracing programs, this means that the user can
easily create stereograms from ray-traced images.

n The non-shareware version will generate up to 256 levels of depth.

n There are no limitations placed on Source and Destination image sizes in the non-shareware
version. Background Images may be as large as 64K pixels.

n Both Divergent (relaxed eyes) and Convergent (crossed eyes) stereograms can be created with
the non-shareware version.

n Alow pass filter can be enabled to help remove unwanted "sprinkles" from ray traces Targa
Source images.

n A Depth Factor parameter allows the amount of depth in the stereogram to be controlled by the
user.

n A Pixel Density parameter allows the user to specify the sparsity of dots in Black & White and
Custom Color RDS images.

n A Pixels/Inch parameter allows the user to target a specific resolution for the final image,
allowing the software to minimize distortion in the depth dimension.

n  An option which works in conjunction with the Pixels/Inch parameter and Depth Factor parameter
to generate the desired quality of image is included, allowing the user to maximize either the
amount of depth impressed into the image, or maximize the depth linearity (quality) of the image.

n The registered version will optionally generate "Guide Dots" on the stereogram, which helps
some people to "lock in on" the hidden image.




Installation

Installation of POPOUT-LITE is easy. Since this shareware is being distributed through a number of
different channels, installation may be different for different users.

Look for a file called INSTALL.EXE or SETUP.EXE on the POPOUT-LITE diskette. If it exists (and it
should), then simply click on the "File" pulldown in the Program Manager window, then click on
"Run". For "Command", type in "A:\INSTALL.EXE"

Substitute another drive letter for your floppy if yours is not drive "A:".

The POPOUT-LITE Install utility will copy all of the necessary files to your hard drive, then create a
program group and program items for POPOUT-LITE.



Introduction

POPOUT-LITE generates Random Dot Stereogram images from drawings that you create. At first
glance, the images that POPOUT-LITE generates appear to be a series of seemingly random dots.
When viewed properly, however, a "hidden" three dimensional image will "POP OUT" of the
stereogram!

POPOUT-LITE was designed to be used in with Paintbrush or some similar drawing tool. POPOUT-
LITE is capable of generating stereograms with up to 16 levels of depth.

POPOUT-LITE can create three different types of output stereogram. The output image can be
either a Black & White RDS, an RDS with 16 randomly chosen colors, an RDS with a color scheme
defined by the user.




Creating a Stereogram

The following are the main steps you will follow in creating a stereogram image:
Create a Drawing
Options

Generate the Stereogram
View and Print the Stereogram
Configuration/Preferences




Create a Drawing

The first step in generating a stereogram image is to design the image that you want to be hidden
within the stereogram. This is the most time-consuming part of the process.

POPOUT-LITE has been designed to accept depth-containing files (called Source Files) that have
been manually created using Paintbrush or something similar. POPOUT-LITE will accept only 16-
color BMP files.

We've designed POPOUT-LITE to be used easily in conjunction with Microsoft Paintbrush, which
most users are familiar with. If you've never used Paintbrush, you may want to spend some time
getting familiar with it. If you prefer another drawing tool, you may certainly use it. POPOUT-LITE's
only requirement is that your drawing be in 16-color BMP format.. For purposes of this document,
we will assume that you are using Paintbrush to create your Source File images.

We recommend that you create your manually-generating drawing by following the steps shown
below:

Redefine the Paintbrush Palette

Initialize the Paintbrush Canvas

Create your Drawing

Save your Drawing

Warning!

Some new users of POPOUT-LITE invariably try to convert a scanned photograph to a stereogram.
You should be aware that THIS WILL NOT WORK! This is not a fault of POPOUT. A scanned
photograph contains NO depth information encoded within it. Colors or greyshades produced by a
scan are NOT the same thing as depth information. POPOUT-LITE (or any other stereogram
generator) has no way of determining relative depth in the image. POPOUT-LITE Source File

images must be created manually (using Paintbrush). For users that require more than 16 levels of
depth, POPOUT-PRO has been designed to accomodate them.




Redefine the Paintbrush Palette

Your distribution diskette contains a Paintbrush Palette definition file called POPOUT.PAL. We
suggest that you redefine the palette using this file.

When you start Paintbrush, you may have noticed that the default Paintbrush palette consists of 28
colors. Since Paintbrush can only save 16 of these uniquely (we don't know why), we've limited
POPOUT-LITE to accepting drawings which are in a 16-color format. This means that in creating
your drawing, you will use at a maximum only 16 colors from the Paintbrush palette.

Click on the Paintbrush "Options" pulldown, then click on "Get Colors...". Select the file
POPOUT.PAL from your POPOUT-LITE directory. This file will redefine the Paintbrush palette such
that all but 16 colors will be "blacked out". Furthermore, the remaining 16 colors will be rearranged

in such a way as to make it easier for you to remember which color will map to which level in the
stereogram.



Initialize the Paintbrush Canvas

Only the left-most 16 colors of the Paintbrush palette (8 on top and 8 on the bottom) will be used in
creating your drawing. If you've redefined the palette with POPOUT.PAL, these colors are the only
ones remaining.

Before starting your drawing, you should clear the canvas to Black. If you've used POPOUT.PAL,
this will be done for you.

Before clearing the canvas, you might want to decide on an image size. Click on "Options", then
"Image Attributes”. Click on the "pels" (meaning pixels) "radio" button. Enter the "Width" and
"Height" of your image. We suggest starting with something small, like 320 Width by 200 Height.

Once you've chosen the size of your drawing, you're ready to clear the canvas. Click on the top-left
color of the palette with the RIGHT mouse button. Click on the "File" pulldown, then click on "New".

Hint:

Later, you may want to experiment with clearing the canvas to a different color. You can get some
interesting "Push In" effects (rather than POP OUT) in your stereograms. Note that this same effect
can be produced by rearranging the Ordering string in the Preferences menu.

Warning:
Don't use any of Paintbrush's "dithered" colors. When you zoom in on your drawing, you should not

see any patterns of "one dot of color1, the next dot of color2, the next dot of color1, etc). Using
these dithered colors will (quaranteed) generate pretty lousy stereograms.



Create your Drawing

This topic refers to the creation of a Source File drawing using Paintbrush to manually draw your
Source File.

Creating your drawing is the most time consuming part of generating a stereogram image. This is
where you will actually draw the image that you want POPOUT-LITE to hide within your stereogram.

Using all of the normal Paintbrush tools, go ahead and create your drawing. The important thing to
remember is that the colors you choose will be interpreted by POPOUT-LITE as "levels". Of the 16
left-most colors, the color on the top left (Black if you've used POPOUT.PAL) will be interpreted as
the level furthest from the viewer. The next color (Dark Red if you've used POPOUT.PAL) is closer
to the viewer. This continues on until the bottom-right color (White if you've used POPOUT.PAL) is
the closest level to the viewer.

Important!

Do not confuse these colors with the colors of your stereogram. The color of your stereogram has
nothing to do with the colors you use to create your drawing. The colors that you use here is simply
a way for you to put depth information into your drawing.

Hint:

If this is your first time, you may want to use a drawing that we've included on your diskette, rather
than creating one of your own. Click on "File", then click on "Open". Select the file EXAMPI1.BMP
from your POPOUT directory. This is a good example of a 16-color drawing that uses all 16 colors.
It will give you a chance to see if your "Overlay" string in your Preferences menu needs to be
changed to make sure that colors are being mapped to the proper levels.

Another Hint:

When you're creating your drawing, try not to have less than 3 or 4 pixels of the same color (level) in
one horizontal row. For example, don't draw a vertical line that is only 1 pixel wide. Because of the
way the illusion works, something like this will be very hard to see in the stereogram.



Save your Drawing

Once you're finished creating your drawing using Paintbrush, you will need to save it to disk in order
for POPOUT-LITE to read it. Your drawing (which POPOUT-LITE calls a Source File) must be in a
16-color BMP format.

To save the drawing, click on the "File" pulldown, then click on "Save As...". In the "Save File as
Type" window, select "16 Color bitmap". Here, you will need to choose a filename, for example,
EXAMPIL.BMP.

Hint:
We prefer to save Source images and Destination images in different directories. This helps from

getting things mixed up. In the Preferences menu, you can specify separate default paths for these
images.



Options

The following two options are available and may be adjusted before Generating your stereogram.
Pattern Width
Pixel Density



Pattern Width

One of the first things you notice when looking at a Random Dot Stereogram is the seemingly
repeating patterns of random dots across the width of the image. We refer to this distance between
repeating patterns as the Pattern Width.

When POPOUT-LITE generates a stereogram, it reads this parameter (which we've arbitrarily
defaulted to 60) to determine how many pixels to generate before repeating the pattern. The
Pattern Width value is specified in Pixels.

Since we don't know the resolution or size of your monitor, and we don't know the resolution of your
printer and whether you'll be scaling your image before printing it, we don't know the physical
distance between patterns in your finished stereogram. This physical distance between patterns is
what increases or decreases the relative "depth" of the image contained within the stereogram. The
wider the pattern, the more depth in the image. Also, the wider the pattern, the more difficult it will
be for some people to see the hidden image.

Depending on your own environment, you will probably want to experiment with different values for
the Pattern Width. We recommend a pattern width of somewhere between three quarters of an inch
to an inch and a half.



Pixel Density

When generating a Black & White or Custom Color stereogram, we have the concept of "foreground”
and "background" pixels. In Black & White stereograms, we consider the White pixels to be in the
foreground, and the Black ones to be in the background. When creating Custom Color
stereograms, we consider the colored pixels to be the foreground pixels, and the "Black" pixels
(which may be redefined to another color) to be the background pixels.

The Pixel Density is a percentage value. It specifies to POPOUT-LITE the percentage of foreground
pixels that should be generated. The default value is 50, which tells POPOUT-LITE that when
creating a Black & White or Custom Color stereogram, make roughly half of the pixels the foreground
color, and half of the background color.

The reason for including the Pixel Density parameter is for generating a stereogram which you intend
to print. Users who copy their stereograms to directly to high density printers (such as the 300 and
600 dots per inch with no scaling) will find that stereograms created with a 50% Pixel Density tend to
be a bit dark. By adjusting this value, a lighter print can be obtained. Allowable values are from 1
to 99 (both 0 and 100 make no sense, as this would produce an image of all foreground or all
background pixels!)

Hint:

You can get some interesting RDS images by using very high or very low values for the Pixel
Density. It really is amazing how sparse your random dots can be, and the human brain is still able
to discern the hidden image. Try setting the Output Style to Black & White RDS, and set the Pixel
Density to 90%. Only 10% of the pixels in the resultant stereogram will be black pixels, but you'll
probably still be able to see the hidden image!

Note:

The Pixel Density is not used when the Output Style is Random, since there is no concept of
foreground or background pixels. In the Random Output Style, all pixel colors are chosen randomly
by POPOUT-LITE.




Generate the Stereogram

Once you've created your Source File drawing using Paintbrush, you're ready to start POPOUT-
LITE.

In the POPOUT-LITE Main Menu, you will specify the Source File drawing and specify a filename for
POPOUT-LITE to save the stereogram, called the Destination File. After filling in a number of
optional parameters, you will be ready to generate your stereogram. The following topics provide a
description of all of the controls in the POPOUT-LITE Main Menu.

Source File

Destination File

Output Style

Color File

Create Color

Pattern Width

Pixel Density
Generate and Exit




Source File

The Source File is the filename of the image that contains the depth information for the stereogram
POPOUT-LITE will create.

If you've manually created this file using Paintbrush, you must save it as
a 16-color BMP image (note that Paintbrush defaults to 256-color; you will need to select 16-color).

In the POPOUT-LITE Main Menu, click on the Source File button, and select the filename of the
drawing that you created.



Destination File

The Destination File is the file which is your stereogram. POPOUT-LITE will create this file. The
purpose of the Destination File button in the POPOUT-LITE Main Menu is for you to specify the
filename.

Hint:

When specifying the Destination Flle name, use a name similar to the name you gave to your Source
File drawing when you saved it in Paintbrush. Down the road, it will help you remember which
drawing was used to create the stereogram. If your Source File drawing is called EXAMPI1.BMP,
you may want to name the Destination file something like EXAMPO.BMP. Or, you may want to
specify a Default Directory for the Destination Images (via the Preferences menu) that is different
than your default Source File directory. It will help you keep your images organized.



Output Style

The Output Style section of the POPOUT-LITE Main Menu consists of three "radio" style
pushbuttons. The Output Style specifies the type of stereogram that you want POPOUT-LITE to
create. The following topics will discuss each of these Output Styles.

Black and White RDS Output Style

Random RDS Output Style

Custom Color RDS Output Style

Hint:

If you're experimenting just to see if you can get a viewable stereogram, and you're using Paintbrush

to create your Source File, you may want to leave the Output Style set to Black & White, as these
take up a lot less disk space than the other Output Styles.




Black and White Output Style

This is the default Output Style. This Output Style selection will tell POPOUT-LITE to generate your
Destination File RDS stereogram using only black and white colors. This output style will generate a
2-color BMP Destination File. These images will typically occupy less disk space, and will generate
a bit faster.




Random Output Style

This Output Style button tells POPOUT-LITE to generate the Destination file stereogram using a
random selection of colors POPOUT-LITE will choose from 16 bright colors for the image.

These stereograms are stored as a 256-color BMP file.

Hint:

POPOUT-LITE chooses from a random selection of relatively bright colors. Since the choice of
colors is random, there's no telling how the stereogram will look. We've added a mecanism to
"steer" POPOUT-LITE into choosing colors of a specified color. You may note on the Main Menu
that the Create Color Button is enabled when the Random Output Style is selected. If you click on
the Create Color Button, then in the Create Color menu select one of the Background Colors, then
press the Cancel button without saving anything, POPOUT-LITE will try to bias the random color
generation toward that color you selected in the Background Color list. It's still random, but the
selected color will tend to appear more often than the other randomly selected colors. For example,
if you were making a stereogram with a St. Patrick's Day theme, you might want to use the Random
Output Style. By pressing Create Color, then selecting LtGreen from the Background list, then
pressing Cancel, the resulting stereogram will tend to have more bright Green than the remaining
colors.

Selecting Black as the Background color tells POPOUT-LITE not to bias the color selection, so that
all colors have the same probability of being used. Note that Black is the default Background color.

Another Hint:

The random number generator within POPOUT-LITE that is used for generating colors for this output
style is "seeded" when POPOUT-LITE is first started, and is never reinitialized as long as POPOUT-
LITE is running. What this means is that if you don't like the color scheme of your stereogram,
simply press Generate again and try a new set of random colors. By using the Create Color
Background color, you can usually get an acceptable color scheme within a few iterations of pressing
Generate.



Custom Color Output Style

This is the Output Style that allows users precise control over the coloring of their Random Dot
Stereograms. Stereograms are stored by POPOUT-LITE in 256-color BMP format. When this
Output Style is selected, POPOUT-LITE needs some mechanism to tell it precisely how to color the
stereogram. It uses something we call a Color File to do this.

Important!

Don't confuse the color of the stereogram with the colors in your Source File. Those colors that you
used in Paintbrush were converted by POPOUT-LITE to "levels" of depth, and have nothing to do
with the color of the stereogram.

The Color File is the mechanism used by POPOUT-LITE to control the color of the stereogram. The
Color File contains, in precise detail, how the color of the stereogram should vary from top to bottom
of the image.

When using this Output Style, you must either create a new Color File by clicking on the Create
Color button, or use a previously created Color File by clicking on the Color File button.

Selecting a Color File

Creating a Color File

Hint:

Color Files are independant of the stereograms. You may eventually have an entire directory
containg many Color Files that you've created. Any Color File may be used to color any
stereogram. We suggest naming color files (which have a default extension of *.POC) such that

they indicate the color scheme. For example, a Color File containing the color scheme "LtRed,
White, LtBlue" may be called something like USFLAG.POC, or RWB.POC.




Selecting a Color File

The rectangular Color File button is used to select a previously created Color File when generating
custom color stereograms. Click on the button, then select the Color File you want POPOUT-LITE
to use when coloring the stereogram (Color Files have a default extension of *.POC).

If you will be creating a new color scheme for the stereogram, you will need to create a new Color
File. In this case, click on the Create Color button.

Color Files are by default stored in the directory specified in the Preferences menu.



Create Color

The Create Color button is used to access the Create Color Window. This window is used to create
a new color scheme, and hence, a new Color File. Color Files are used in the creation of Custom
Color stereograms. The Background Color may also be used to statistically bias POPOUT-LITE in
the selection of colors for the Random Output Style.

The Color File is a simple text file which describes to POPOUT-LITE how to color your stereogram.
In a Custom Color stereogram, we consider some of the pixels to be foreground pixels, and others to
be background pixels. The foreground pixels of the Custom Color stereogram may vary in color
from top to bottom of the image. The background pixels all have the same color value.

When you press the Create Color button, a window which we call the "Create Color File" window
pops up. In this window, you may select any number of colors from 1 to 50 to make up the color
scheme of the foreground pixels in your stereogram. You may also select the color of the
background pixels.

For a detailed description of the "Create Color File" window, refer to the topic "Create Color File
Window". For a detailed description of the structure of a Color File, refer to the topic "Structure of
the Color File".

Create Color File Window

Structure of a Color File




Create Color File Window

"Create Color File" is the name of a POPOUT-LITE window that is opened when you press the
"Create Color" button. The main purpose of the window is to allow the user to create a color
scheme for Custom Color stereograms, and hence a Color File. The window may also be used to
bias POPOUT-LITE's selection of colors for Random Color RDS images.

The "Create Color File" window has the following controls:
Foreground Color Buttons

Background Color Select

Clear Button

Save and Cancel Buttons




Foreground Color Buttons

The "Create Color File" window contains sixteen buttons along the left side of the window. These
buttons are used to create a color scheme for the foreground pixels in Custom Color Stereograms.

You may press any combination of the sixteen color buttons from 1 to 50 times. By the sequence
and number of button presses, you will define how you want the color of foreground pixels to vary
from the top to bottom of the stereogram.

For example, if you press the buttons LtRed-White-LtBlue, the foreground pixels of the stereogram
will vary gradually from LtRed at the top of the image to White in the middle, then finally from White
to LtBlue at the bottom.

As you press a color button, a list is maintained and displayed to remind you of the color scheme
you're designing.

Hint:

Color buttons may be pressed more than once. For example, the key presses LtRed-White-LtBlue

will produce a color scheme different than pressing LtRed-LtRed-White-White-LtBlue-LtBlue.
Experiment.

Another Hint:

If you've made a mistake, you can delete colors from the displayed list. Click on the entry in the list
to highlight it, then click on the Clear Button.




Background Color Select

To the right of the "Create Color File" window is a "combo box" which allows you to select the color of
the background pixels in a Custom Color stereogram.

The default color of these background pixels is Black.

Hint:
If you will be printing this stereogram, try using White as the background color. The resulting
stereogram will tend to be less "busy" looking.

Another Hint:

When the Output Style is selected as Random RDS, POPOUT-LITE will randomly choose from the
16 colors shown in the Create Color Window to make up the colors of your stereogram. Murphy
states that POPOUT-LITE will tend to choose colors you don't like! It really is a random selection,
and every time you press the Generate button, you'll get a new random color scheme. We've added
a mechanism to try and "steer" POPOUT-LITE into emphasing a particular color when making its
random selection. For example, if you're creating an RDS with a St. Patrick's Day theme, you may
want to generate a Random color RDS that is "heavy on the green". In the Create Color Window, if
you select the Background color as anything other than Black, POPOUT-LITE will try and give that
selected color more priority over all others when making a random color selection. The resulting
stereogram will tend to have more pixels of that selected Background color contained init. You
don't have to save this to a color file, just choose the color from the list, and POPOUT-LITE will
remember it. If the Background color is Black, POPOUT-LITE will pick all colors with the same
probability.




Clear Button

The Clear button in the "Create Color File" window has two purposes. When selecting a foreground
pixel color scheme, a list of the colors you've chosen appears in the center of the window. If you
click on one of the colors in the list to highlight it, then press the Clear button, the entry will be
deleted from the list. If you press the Clear button when no entries in the list are highlighted, all of
the entries are deleted.



Save and Cancel Buttons

Once you've chosen a list of foreground colors, and selected a background color, click on the Save
button to create a Color File. You will be prompted for a filename for the Color File. POPOUT-LITE
Color Files have a default extension of *.POC.

Once you've saved your color scheme into a Color File, the "Create Color File" window will close,
and the name of your newly created Color File will be entered into the "Color File" space in the
POPOUT-LITE Main Menu.

If you've decided that you don't want to be generating a Custom Color stereogram afterall, click on
the Cancel button to close the "Create Color File" window.

If you've pressed the Create Color Button because you want to bias the random selection of colors
for the Random RDS Output Style, you don't need to save anything. Pressing Cancel will tell
POPOUT-LITE to remember the Background color you selected, and this color will be the "preferred"
color when POPOUT-LITE creates your Random Color RDS.




Structure of a Color File

Most users will probably never have any need or desire to manually modify a Color File. Since a
Color File is a simple text file which can be edited using an editor such as Notepad, you may very
well want to "tinker" with Color Files.

In the interest of simplicity, we designed the "Create Color File" window to create Color Files
containing full and half intensity primary and secondary colors, as well as White and Black. By
"tweaking" a Color File, you can create color schemes including many other colors. Therefore,
we've included this topic to discuss the structure of a Color File.

As previously mentioned, a Color File is a simple text file. The Color File can contain any number of
lines. Each line contains a command to POPOUT-LITE. There is a very strict syntax that must be
adhered to in a Color File (remember, since Color Files are generated by POPOUT-LITE's "Create
Color File" window, there's normally never a problem - problems only occur when you modify a Color
File).

Each line in a Color File must begin with one of four words: RED, GREEN, BLUE, or BLACK (case
does not matter). Any number of lines may begin with the words RED, GREEN, or BLUE, but only
one line may begin with the word BLACK. Furthermore, the line beginning with the word BLACK
must be the last line in the Color File.

For lines beginning with the words RED, GREEN, or BLUE, the syntax is as follows:
COLOR STARTC ENDC STARTY ENDY
where:

COLOR is either RED, GREEN, or BLUE

STARTC is the beginning intensity (in percent) of the color
ENDC is the ending intensity (in percent) of the color
STARTY is the beginning line (in percent) of the stereogram
ENDY is the ending line (in percent) of the stereogram

STARTC, ENDC, STARTY and ENDY are all integer numbers between 0 and 100 (inclusive),
preceeded by one space. ENDY must always be a larger number than STARTY.

For the line beginning with the word "BLACK", the syntax is:
BLACK REDC GREENC BLUEC
where:

REDC is the amount (in percent) of Red in the background pixels
GREENC is the amount (in percent) of Green in the background pixels
BLUEC is the amount (in percent) of Blue in the background pixels.

REDC, GREENC, and BLUEC must all be integer numbers between 0 and 100 (inclusive).

For example, the line:

RED 0 100 0 100

would be interpreted by POPOUT-LITE to mean, "Gradually vary Red from 0% intensity to 100%
intensity, from 0% down the image (the top) to 100% of the way down the image (the bottom). In
other words, this command will ramp any red in the image from full-off at the top of the stereogram,
to full intensity at the bottom.

The following example is a Color File generated by pressing the sequence LtRed-White-LiBlue in the
"Create Color File" window, and selecting LtYellow as the background color. Note that this
sequence will cause the foreground pixels in the stereogram to be Red at the top of the image,
gradually fading into White in the middle, then onto Blue at the bottom. The background pixels will
be Yellow.

RED 100 100 0 50
RED 100 0 50 100
GREEN 0 100 0 50
GREEN 100 0 50 100



BLUE OO 050
BLUE 0 100 50 100
BLACK 100 100 0

The above example Color File would be interpreted by POPOUT-LITE as follows:
The first line would be read by POPOUT-LITE as, "Vary Red from full-on at the top of the image, to
full on in the middle of the image". In other words, Red stays at full-on for the top half of the image.

The second line would be interpreted as, "Vary Red from full-on in the middle of the image to full-off
at the bottom".

The third line tells POPOUT-LITE to vary Green from full-off at the top to full-on in the middle, and
the fourth line says to ramp green from full-on in the middle to full-off at the bottom.

The fifth and sixth lines ramps Blue from full-off at the top to full-on in the middle, then to stay at full-
on for the bottom half.

When POPOUT-LITE combines all of this information when creating foreground pixels, we see that
there is no Green or Blue at the top of the image, but lots of Red. So, the very top of the image will
be Red. For the top half of the image, Green and Blue gradually increase in intensity so that in the
middle, we have full intensity of all three colors, resulting in White in the middle (Red + Green + Blue
= White). Moving from the middle to the bottom of the image, both Red and Green fall to full-off,
while Blue stays at full-on. So, in the bottom half of the image, we fade from White to Blue.

The last line of the Color File redefines the Black, or background pixels, to be full-intensity Red and
full-intensity Green, but no Blue. Red + Green = Yellow, so the background pixels will be Yellow.

Hint:

If you're in there fiddling with Color Files, make sure and "overlap" both color and position values.

For example, in the two lines above that describe Red, the middle of the image (50%) is defined in
both lines. Don't do something like:

RED 100 100 0 50

RED 100 0 51 100

In the above example, we haven't "covered" the area between 50% and 51% of the way down the
image.



Color File

The Color File button is used when you want POPOUT-LITE to create a stereogram with a color
scheme that you have previously defined and stored on your disk as a Color File. The Color File
button is used to select the Color File. This button is enabled only when you've selected the Output
Style to be Custom Color.

Color Files are independant of stereograms. You may in time have a directory full of miscellaneous
Color Files. Any Color File may be used to define the color for any Custom Color stereogram.

To create a Color File, refer to the topic "Create Color".

Create Color

Hint:

Color Files have a default extension of *.POC. Name a Color Files to be descriptive of the color

scheme it defines, not the stereogram you're using it to create. For example, a Color File that
describes the color scheme "LtRed, White, LtRed" might be named something like USFLAG.POC.




Generate and Exit

The Generate button in the POPOUT-LITE Main Menu is the "DO IT" button. Once you've set up all
of the controls, click on the Generate button.

POPOUT-LITE will read your Source File drawing, and any appropriate controls that you've set
(Output Style, Pattern Width, etc). POPOUT-LITE will then create a file on your disk with the name
you gave as the Destination File. This file is your stereogram. POPOUT-LITE displays a status bar
at the bottom of the menu to provide feedback as to where it is in generating your stereogram.
Depending on the speed of your computer, you may never even notice it.

Once POPOUT-LITE has finished generating your stereogram Destination File, you may exit
POPOUT if you wish. The "Exit" button is used to exit POPOUT.

Hint:

Since the RDS is based on randomly generated pixels, sometimes you may get a stereogram that
just doesn't "look right". A glob of blue pixels here, a glob of black pixels there, etc. Each time you
press the Generate button, POPOUT-LITE uses a different set of random numbers, so keep hitting
Generate, view the stereogram via the "View" pulldown, and hit Generate again, etc., until you get a
stereogram that you like.



View and Print the Stereogram

Once you've clicked on the Generate button in the POPOUT-LITE Main Menu and POPOUT-LITE
generated your stereogram, you will want to view it. You can use the "View" pulldown in the main
window, which by default will also start Paintbrush. You can then print your stereogram from within
Paintbrush.

Printing a stereogram is not the same as printing a normal image. Because of the nature of the

optical illusion, it is important to follow some certain "rules" for best results. Refer to the topic "Hints
for Printing".

Hints for Printing




Hints for Printing

Paintbrush contains a nice mechanism for printing your stereograms. There are a few tips,
however, that we've included so that you produce the nicest looking hardcopy.

n Always use the Printer Resolution. When you print using Paintbrush, there is a box in the
Paintbrush Print window labelled "Use Printer Resolution". Always 'X' this box. If you don't,
you may see vertical ridges or lines in your stereogram.

n Try to scale by integer multiples of 100. In the Paintbrush Print window, scale by numbers like
100%, 200%, 300%, etc. Otherwise, you may see the same vertical lines or ridges mentioned
above.

n Depending on the resolution of your printer, and the scaling factor mentioned above, you may
need to go back and recreate your stereogram with a different value for the Pattern Width in the
POPOUT-LITE Main Menu. On paper, the distance between repeating patterns should be
around an inch to an inch and a half.

n If you've generated a Black & White stereogram, and your printing to a black and white printer,
you may notice that the stereogram is a bit dark, especially if you have a high resolution printer
and your print scale factor is small. Go back and re-generate your stereogram with a higher
value for the Pixel Density in the POPOUT-LITE Main Menu.

n We've had some good experience with taking stereograms to the local quick-copy store. For a
small fee, these places (assuming they have the equipment) can read an image, and send it
directly to a color copier. The results are impressive, and by far the best quality for the buck.

For a High Resolution Printer (> 300 dpi)

If you intend to print your stereogram at a very high resolution, keep in mind that what you can print
is far more resolute than what can be displayed on your CRT; perhaps by as much as a factor of 10
or more. This means that you may be able to produce an image which while unviewable on the
CRT (because of a huge pattern width), is perfectly fine when printed. Keep in mind that a most
important factor in the quality of your stereogram is the linear pattern width; try to keep it between an
inch and two inches. On a 300 dot per inch printer, for example, you want a pattern width around
300 or 400 pixels. This image would be difficult to view (if not being totally non-viewable) on an 80
pixel per inch CRT (making the linear width over 3 inches), but would look just fine on a printer,
where the linear patter width would be about an inch.

Hint:
If, when viewing your stereogram, you see more levels than you expect, try increasing the Pattern
Width. If your stereogram is difficult to "lock in on", try decreasing the Pattern Width.



Preferences

The Preferences menu is accessed by clicking on the "Configuration" pulldown in the POPOUT-LITE
main menu. This menu allows you to specify your default image viewer, and the default pathnames
of your images and color definition files.

Note:

When you click the "Save" button in the Preferences menu, your default selections will be saved to
disk, and will be used each time you start POPOUT-LITE.

Default Viewer
Default Directories




Default Viewer

The "Viewer" button in the Preferences window allows you to specify a default image viewer. This is
the viewer that is used when you select the "View" pulldown in the POPOUT-LITE main menu. By
default, we've selected the Viewer program to be "PBRUSH.EXE", which is Paintbrush. You should
never need to change this setting unless you prefer using another viewer program.

Note:

The Default viewer must be located somewhere in your system PATH specified in your
AUTOEXEC.BAT file.



Default Directories

The Default Directories specified in the POPOUT-LITE Preferences menu specify the default

locations of your various POPOUT-related files. This is handy if you choose to keep Source Files in
one directory, Destination Files in another directory, etc.

Note:
This Default Directory information is saved, and will be used each time you start POPOUT-LITE.



Hints for Viewing

Some folks will have no problems in viewing your stereogram images. Others may need a bit of
help. Below is a list of "hints" that we've compiled from different people.

n

Start with your head about a foot or so from the image. Stare at it and let your eyes relax. If
things start to move out of focus, let them. Keep staring.

With your head about a foot from the image, suddenly move toward the image, and try not to
refocus.

Stare at something at a far wall. Then, suddenly, glance at the image. Don't try to refocus on
the image.

Get your nose right up to the image. Gradually (or for some people, quickly) move your head
back.

Practice by drawing two dots on a piece of paper about an inch or so apart. Stare at them and
let your eyes relax. Both dots should go out of focus, and you will see a total of four fuzzy dots.
Keep staring. As the two middle fuzzy dots start to move toward each other, let them. There
will be a point where the two middle fuzzy dots meet, and you will see a total of three dots, where
the one in the center is clear, and the two edge dots are fuzzy. This is what you need to be
doing to your eyes to see the stereogram image.

On a printed RDS, draw two dots like in the above hint just above the stereogram, at a distance
identical to the pattern width. Once you stare and see three dots, gradually move your eyes
down into the stereogram without trying to refocus. Some RDS generators do this automatically.
Personally, we think it's dumb. You can always do this yourself with a pencil, or inside
Paintbrush. Of course, with a Dual-Image stereogram, you don't need this.

Put your stereogram behind a piece of glass, then stare at your reflection in the glass.



Problems, Suggestions, etc.

If you've encountered some sort of problem in trying to generate a stereogram image using
POPOUT-LITE, our first recommendation is to rummage through this Help file. We've tried to
include a number of tips and suggestions to give you the best possible results. Chances are, the
answer to your question is buried in this Help file somewhere.

If not, or if you have any other problems, either contact the agent or merchant that sold you your
software. If he or she can't answer your question, you can contact the authors by way of the
addresses shown below:

POPOUT
C/O Bob Hankinson
P.O. Box 50632

Dallas, Texas 75250
Or via the Internet, America OnLine, or CompuServe:

Internet or AOL: BHankinson@aol.com
CompuServe: 73144,1046



How to Register

To register this shareware copy of POPOUT-LITE, and receive a free copy of the non-shareware
version, simply click on "Help" in the POPOUT-LITE main menu, then click on "Register POPOUT-
LITE". A printable order form will be displayed.

Also, if you restart POPOUT-LITE, you can click on the "Order Form" button that will appear in the
opening window.

The Order Form may be printed by clicking on the "File" pulldown in the Order Form window, then
clicking on "Print Topic".

If you require more capability than is provided by the registered version of POPOUT-LITE, you may
be interested in registering a copy of POPOUT-PRO.



Allowable Image Formats

Source File Formats
POPOUT-LITE will accept only a 16-color BMP image as a Source File.

Note:

We have purposely NOT chosen some more common image formats as acceptable Source File
formats. Inevitably, we will receive mail that suggests, "Why don't you modify POPOUT-LITE to
accept GIF format images, as | have plenty of GIF's that I'd like to create stereograms from."

As mentioned elsewhere, scanned images contain no depth information, and are therefore
unacceptable as Source File images! POPOUT-LITE (or any other stereogram generator) has no
way of determining relative depth in the image. Color and brightness are NOT the same as depth.

Destination File Formats

POPOUT will create stereograms in either 2-color or 256-color BMP format. Black & White images
are stored as 2-color BMP, while Random and Custom color images are stored in 256-color BMP
format.



BMP Level Mapping

When your Source Image is a 16-color BMP file, POPOUT-LITE expects a certain set of colors. If
you've used POPOUT.PAL to define your colors from within Paintbrush, then you shouldn't have a
problem. There is, however, a slight chance that with your particular configuration, Paintbrush will
not save all 16 colors uniquely. If so, try restarting Windows in another color mode. We've had luck
with Windows in 16 or 256 color modes, but have found that some graphics drivers will not allow
Paintbrush to save all 16 colors uniquely in 64K or true-color mode. If there is a problem, it will most
likely be in that you will lose one of your gray shade colors.

The following is a list of colors that are defined in POPOUT.PAL, in the order that POPOUT-LITE
maps them to levels. The first color in the list, Black, is mapped to the level of depth furthest from
the viewer. The last color, White, will become the level closeset to the viewer.

Black

Dark Red
Dark Green
Dark Yellow
Dark Blue
Dark Magenta
Dark Cyan
Dark Grey
Light Grey
Light Red
Light Green
Light Yellow
Light Blue
Light Magenta
Light Cyan
White



BMP Source File Colors

When using a 16-color BMP format drawing as a POPOUT-LITE Source File, POPOUT maps colors
in the Source File to levels of depth in the stereogram. We suggest that you use the colors defined

in POPOUT.PAL. Refer to the topic "BMP Level Mapping" for a list of how colors are mapped to
levels.

BMP Level Mapping




Definition of Terms

The following are descriptions of some of the terms that appear in this Help file.

Source File

The Source File is the primary input to POPOUT-LITE. This is the file that contains the depth
information that will be used by POPOUT-LITE to create the stereogram. This file must be a 16-
color BMP file (which is easily created using Paintbrush).

Destination File

The Destination File is the file that POPOUT-LITE creates. This is the stereogram image.
POPOUT-LITE will create either a 2-color or 256-color BMP file.

Output Style

The QOutput Style refers to the type of stereogram that POPOUT-LITE will create. POPOUT-LITE is
capable of creating three distinct types of stereogram images. Three are all types of Random Dot
Stereograms. We refer to these three output styles as Black & White, Random Color, and Custom
Color. Black & White RDS images are easy to generate and typically occupy less disk space.

They make nice images for hardcopy. Random Color RDS images consist of 16 colors chosen
randomly by POPOUT-LITE. = Custom Color RDS images use a color scheme created by the user
and stored in something called a Color File. Color Files are only used when creating Custom Color
RDS images.



UK Order Form

Masl;;effta

Oakley Data Services
3 Oakley Close, Sandbach,
Cheshire CW11 9RQ, England

Call +44 (0)270 759739
Fax +44 (0)270 765272
CIS: 100024,1763

Note: You can print this Order Form by selecting the "File" pulldown above, then clicking on "Print
Topic".

To:
Oakley Data Services, 3 Oakley Close, Sandbach,
Cheshire CW11 9RQ, England

Please send me registered copy(s) of (select one):
POPOUT-LITE POPOUT-PRO

Also, please send Shareware Versions of some of your other fine software.

PRICES:

POPOUT-LITE:

UK and EEC:
17.00 Pounds Sterling including P&P, plus VAT (17.5%) = 19.97 Pounds Sterling per copy.

Outside the EEC:
17.00 Pounds Sterling plus 2.00 Pounds Sterling P&P = 19.00 Pounds Sterling per copy.

POPOUT-PRO:

UK and EEC:
29.95 Pounds Sterling including P&P, plus VAT (17.5%) = 35.19 Pounds Sterling per copy.

Outside the EEC:
29.95 Pounds Sterling plus 2.00 Pounds Sterling P&P = 31.95 Pounds Sterling per copy

Unless otherwise requested, we ship 3.5" HD disks.

Total Price:

Inclose a cheque / wish to pay by MasterCard / Visa (delete as applicable)
Credit Card Details:

Name as on card:




Card Number:
Expiry Date:

Please send the software to:

Name:

Address:

Post Code: Daytime Telephone:
You can also contact us by:

Phone: +44 (0)270 759739

Fax: +44 (0)270 765272

Compuserve: 100024,1763

It would help in our distribution efforts if you tell us where you found your shareware copy of
POPOUT-LITE. Also, please include any ideas for future enhancements:




USA Order Form

Note: This Order Form can be printed by clicking on the "File" pulldown above, then clicking on
"Print Topic".

Please send me copy(s) of (select one):
POPOUT-LITE POPOUT-PRO

Send the software to:

Name:
Street/Apt:
City/State/Zip:

Unless otherwise noted, we ship 3.5" diskettes.

PRICES:

POPOUT-LITE:

Registration Fee: $20.00
Sales Tax (TX Residents must add $1.50):

Total:

POPOUT-PRO:

Registration Fee: $30.00
Sales Tax (TX Residents must add $2.25):

Total:

Make checks payable to "POPOUT", and send your registration to:

POPOUT
P.O. Box 50632
Dallas, Texas 75250

Please note:
Orders to the above address from countries outside the United States must be paid for in US Dollars
and checks must be drawn on a US Bank. Otherwise, you must include an $8.00 collection fee.

If you have any questions, comments, or suggestions, the authors can be contacted via
Compuserve, America OnLine, or the Internet. Email is typically answered within a day. Please
use one of the following addresses:

Compuserve: 73144,1046
America OnLine: BHankinson
Internet: BHankinson@aol.com

Also, it would help in our distribution efforts if you could tell us where you received your shareware
copy of POPOUT-PRO! And thanks!
Bob Hankinson & Gary Peterson



Background color

The Background Color in the Create Color menu is used to specify the color of background pixels in the
Custom Color Output Style, and is also used to bias the random selection of colors in the Random Color
Output Style.



Background File

This is the file that contains the image that will be tiled and distorted to produce the Dual-Image type of
stereogram.



background pixels
Pixels in a Custom Color stereogram that all have the same color



Black & White
A stereogram Output Style consisting only of black and white pixels



BMP

A standard image format. Stands for "bitmap"



Cancel
Use this button to exit POPOUT.



Color File
Contains the color information for generating Custom Color stereograms



Create Color File
A window that pops up when the "Create Color" button is clicked



Create Color
Use this button to create a new color scheme.



Custom Color
A stereogram where the user designs the color scheme



Destination File
This is the file that POPOUT creates that contains your stereogram.



Dual-Image

This is a type of stereogram generated by tiling a background image, and distorting the tiled image in
such a way as to hide another image within it.



EXAMPI.BMP
A sample Source File drawing included with this diskette.



foreground pixels

The white pixels in Black & White stereograms, and the colors that are varied in Custom Color
stereograms.



Generate
Use this button to create the stereogram.



GIF

You've probably got some images stored in GIF format. POPOUT doesn't support this format just so
you won't try creating stereograms of your scanned image. It won't work. Trust us.



Output Style
Specifies the type of stereogram that POPOUT will generate



Paintbrush

Paintbrush is a drawing tool included with Microsoft Windows. POPOUT was designed specifically to
be used with Paintbrush.



palette

At the bottom of the Paintbrush window is the palette of colors you use in drawing. With POPOUT, only
use the left-most 16 colors.



Pattern Width
The distance in pixels between repeating patterns in the stereogram



Pixel Density
For Black & White and Custom Color stereograms, the percentage of pixels that are foreground pixels.



POC

Default Color File extension



POP160RG.POT

A Translate File included with this diskette



POPOUT

POPOUT is a Windows based Random Dot Stereogram generator.



POPOUT.PAL

This is a Paintbrush palette definition file that blackens all but the left-most 16 colors in the Paintbrush
palette.



POPOUT.POT

A Translate File included with this diskette



POPOUT16.POT

A Translate File included with this diskette



Random
A stereogram Output Style consisting of randomly chosen colors



RDS

Random Dot Stereogram



scan
Scanned photographs are not suitable for stereograms as they contain no depth information.



seed

The random number generator used for the Random Color Output Style is seeded, or initialized, when
POPOUT is first started, then is not touched as long as POPOUT is running.



Source File
This is the drawing your create which will be "hidden" within the stereogram.



Stereogram



Targa
The Targa format is the "format of choice" of popular ray tracing software. POPOUT supports Type 1, 2
and 3 Targa formats.



TGA

Targa format



Translate File
A text file that provides the "final word" on how POPOUT will convert colors to levels.









